
Experiment GB-2: Membrane 
Permeability

Background
Cells are the basic units of life. Cells are aligned with 

other cells to form tissues, tissues align to form organs, 
and organs align to form organisms. But, the life of a 
organism is always dependent on the biochemical 
reactions taking place in the one, or hundreds, or 
millions of cells that constitute an organism.

The biochemical reactions are able to take place in a 
cell because the enzymes, substrates, and products of 
these reactions are contained within the cell by a 
structure known as the cell membrane. Some reactions, 
like the ones that produce cellular energy, take place in 
organelles that are separated from the cytoplasm by 
membranes.

The cell membrane is more than just a barrier that 
separates the contents of the cell from the surrounding 
environment. The cell membrane regulates the 
movement of molecules, that could be nutrients or waste 
products, into or out of a cell. Since some, but not all, 
particles are allowed to move across cell membranes, 
membranes are considered to be selectively 
permeable. 

The processes by which molecules move across cell 
membranes, and the rates at which they do it, are 
dependent on the type of molecule and its size, electrical 
charge, and concentration on either side of the 
membrane. Processes that consume energy are 
classified as active transport, and those that do not 
require energy are considered to be forms of passive 
transport.

In this experiment, students will examine some of the 
properties of passive transport across a model of a 
membrane created with dialysis tubing. Each sac 
created with dialysis tubing will be filled with one of 
three different solutions, each containing a different set 
of ions. When each dialysis sac is placed in a beaker of 
deionized water, ions will move across the membrane. 
The movement of ions between the dialysis sac and the 
surrounding water will be indicated by a change in the 
pH of the water surrounding the dialysis sac.

Equipment Required
PC Computer

IWX/214 data acquisition unit

USB cable

IWX/214 power supply

ISE-100 combination pH electrode

Magnetic stirrer

Stir bar

Ringstand

Utility clamps (2) 

100 ml beakers (2)

250 ml beakers (6)

1000 ml beaker

pH 4 and pH 7 buffer solutions

1.0M HCl solution

1.0M NaOH solution

1.0M Na Acetate solution

2 cm wide dialysis tubing

String

Binder clips (3)

Deionized water

IWX/214 Setup
1 Place the IWX/214 on the bench, close to the computer.

2 Check Figure 1-1 in Chapter 1 for the location of the USB 
port and the power socket on the IWX/214.

3 Use the USB cable to connect the computer to the USB port 
on the rear panel of the IWX/214. 

4 Plug the power supply for the IWX/214 into the electrical 
outlet. Insert the plug on the end of the power supply cable 
into the labeled socket on the rear of the IWX/214. Use the 
power switch to turn on the unit. Confirm that the red power 
light is on.

Start the Software
1 Click the Windows Start menu, move the cursor to 

Programs and then to the iWorx folder and select 
LabScribe; or click on the LabScribe icon on the Desktop

2 When the program opens, select Load Group from the 
Settings menu.   

3 From the dialog box, select AddedLabs.iws. Click Load.

4 Click on the Settings menu again and select the 
MembranePermeability settings file.

5 After a short time, LabScribe will appear on the computer 
screen as configured by the MembranePermeability 
settings. Open the View menu and select Voltmeter to 
display the current pH level to appear on the Main window.
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pH Electrode Setup
Plug the DIN connector on the end of the cable of the 

ISE-100 pH electrode into Channel 4 on the iWorx unit 
(Figure GB-2-1 on page 2).

 Figure GB-2-1: The arrangement of the stirrer, electrode, and beaker for 
measuring the changes in the pH in model of a membrane.

Calibration of the pH Electrode
1 If the pH electrode is still stored in its bottle of buffer, 

remove the electrode from the bottle. Rinse the electrode 
with deionized water while holding the electrode over a 
1000 ml beaker used for the collection of waste liquids.

2 Place the tip of the pH electrode in a 250 ml beaker 
containing enough room temperature deionized water to 
submerge the tip. Keep the electrode in deionized water for 
at least ten minutes.

3 Prepare two 100 ml beakers filled with the pH buffers used 
for calibrating the pH electrode. The buffers should be a 
room temperature. One beaker is filled with pH 7 buffer; and 
the other is filled with pH 4 buffer. Each beaker should be 
filled with enough buffer to cover the tip of the pH electrode, 
and also allow the stir bar in the beaker to spin without 
touching the pH electrode.

4 Place the beaker containing the pH 7 buffer on the magnetic 
stirrer (Figure GB-2-1 on page 2). Carefully place a stir bar 
in the beaker. Remove the pH electrode from the deionized 
water and blot any drops of water from the electrode. 
Position the tip of the electrode in the beaker of pH 7 buffer 
so that the tip is away from the stir bar. Adjust the speed of 
the stirrer so the stir bar is rotating evenly at a moderate 
speed. 

5 Click Start on the LabScribe Main window to begin 
recording. The trace will eventually reach a stable baseline 
toward the top of the recording channel. Type the words 
Calibration - pH 7 on the comment line to the right of the 
Mark button. Press the Enter key on the keyboard to mark 
the stable baseline of the recording. This comment marks 
the output of the pH electrode in pH 7 buffer at room 
temperature. Continue recording while changing the 
beakers of buffers.

6 Turn off the stirrer and remove the pH electrode from the 

beaker of pH 7 buffer. Hold the electrode over the beaker 
used for collecting waste liquid, and rinse it with deionized 
water from a wash bottle. Blot any drops of water from the 
electrode.

7 Remove the beaker of pH 7 buffer from the stirrer and place 
the beaker of pH 4 buffer on the stirrer. Carefully place a stir 
bar in the beaker. Position the tip of the pH electrode in the 
beaker of pH 7 buffer so that the tip of the electrode is away 
from the stir bar. Adjust the speed of the stirrer so the stir 
bar is rotating evenly at a moderate speed.

8 As you continue to record, the trace will reach a stable 
baseline toward the bottom of the recording channel. Type 
the words Calibration - pH 4 on the comment line to the 
right of the Mark button. Press the Enter key on the 
keyboard to mark the stable baseline of the recording. This 
comment marks the output of the pH electrode in room 
temperature pH 4 buffer. Click Stop to halt the recording. 

9 Select Save As in the File menu, type a name for the file. 
Choose a destination on the computer in which to save the 
file (e.g., a class folder). Click the Save button to save the 
file (as an *.iwd file). 

10 Turn off the stirrer. Remove the pH electrode from the 
beaker of pH 4 buffer. Hold the electrode over the beaker 
used for collecting waste liquid, and rinse it with deionized 
water from a wash bottle. Blot any drops of water from the 
electrode and place it in a beaker of deionized water.

Units Conversion
1 Locate the section of the recording where output of the pH 

electrode was measured in pH 4 and pH 7 buffers. To view 
this section of the recording in its entirety on the same 
window, it may be necessary to click either of the Display 
Time icons in the LabScribe toolbar (Figure GB-2-2 on 
page 2). 

 Figure GB-2-2: The LabScribe toolbar.

2 Click the 2-Cursor icon (Figure GB-2-2 on page 2) so that 
two blue vertical lines appear over the recording window. 
Place one cursor on the plateau recorded while the pH 
probe was in pH 7 buffer. Place the other cursor on the 
plateau recorded while the pH probe was in pH 4 buffer.

3 Right-click on the Channel 4 window to open the right-
click menu. Select Units from the right-click menu. Note 
that the voltage values for the positions of Cursors 1 and 2 
are already entered in the units conversion window. 

• Next to the voltage value for Cursor1, enter 7. 

• Next to the voltage value for Cursor2, enter 4. 

• Next to the unit name, enter pH.

• Click OK. The units on the Y-axis are equal to pH units.
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Preparation of the Dialysis Tubes
1 Obtain three pieces of two centimeter-wide dialysis tubing 

that are fifteen centimeters long. Soak the tubing in 
deionized water to soften them.

2 Tie one end of each dialysis tubing with string to form a sac.

3 Fill one of the sacs about two-thirds full with 1.0M HCl. 
Folder over the top of sac and place a binder clip over it.

4 Rinse the outside of the dialysis sac containing the 1.0M 
HCl with tap water to remove any acid that may have gotten 
on the outside.

5 Stand the completed dialysis sac with 1.0M HCl in a clean, 
dry 250 ml beaker to keep the sac clean

6 Repeat Steps 3, 4, and 5 to make a sac filled with 1.0M 
NaOH and a sac filled with 1.0M Na Acetate. Put each 
dialysis sac in its own clean, dry 250 ml beaker.

Exercise 1: Movement of Small Positive Ions 
Across a Membrane

Aim: To determine if small, positively charged, 
hydrogen ions can move across a membrane from a 
region of higher concentration (1.0M HCl) to a region of 
lower concentration (deionized water). 

Procedure
1 Place a magnetic stirrer on or next to the base of a 

ringstand. Place 100 mL of deionized water, at room 
temperature, in a clean 250 ml beaker. Add a stir bar to the 
beaker and place the beaker on the magnetic stirrer. Turn 
on the stirrer and position the stir bar to one side of the 
beaker bottom.

2 Remove the pH electrode from the beaker of deionized 
water. Blot the drops of deionized water from each device. 
Mount the electrode in a clamp on the ringstand. Position 
the pH electrode over the beaker of deionized water. Then, 
lower the tip of the electrode into the water. 

3 Turn on the stirrer so that the stir bar rotates evenly and 
moderately.

4 Click Start on the LabScribe Main window to begin 
recording. When the recording on the channel reaches a 
stable baseline, type the words Deionized Water on the 
comment line to the right of the Mark button. Press the 
Enter key on the keyboard to mark the recording.

5 After recording at least fifteen seconds of stable baseline, 
type the words Add Dialysis Tube w/ 1.0M HCl on the 
comment line.

6 Suspend the dialysis tube containing 1.0M HCl over the 
beaker of deionized water. As you lower the dialysis tube 
into the deionized water, press the Enter key on the 
keyboard to mark the recording. Tighten the clamp holding 
the dialysis tube so that about half the solution in the tube is 
below the surface of the deionized water. Make sure the 
bottom of the dialysis tube is not touching the stir bar.

7 Record the pH of the deionized water for five minutes. At 
the end of five minutes, click Stop to halt the recording. 

8 Select Save in the File menu. 

9 Turn off the magnetic stirrer. Remove the dialysis tube with 
the 1.0M HCl from the beaker and discard the 1.0M HCl as 
directed.

10 Remove the pH electrode from the beaker. Hold the 
electrode over the beaker used for collecting waste liquid, 
and rinse it with deionized water from a wash bottle. Blot 
any drops of water from the electrode and place it in a 
beaker of deionized water.

11 Remove the stir bar from the beaker of deionized water and 
rinse it with deionized water from a wash bottle. Discard the 
deionized water.

Data Analysis
1 Scroll to the section of data recorded during Exercise 1. Use 

the Display Time icons on the LabScribe toolbar (Figure 
GB-2-2 on page 2) to complete recording from Exercise 1 
on the Main window.

2 Click on the 2-Cursor icon in the LabScribe toolbar (Figure 
GB-2-2 on page 2), so that two blue cursors appear over the 
Main window. 

3 Place a cursor on the stable baseline recorded just before 
the dialysis tubing containing 1.0M HCl was lowered into the 
beaker of deionized water. Place the second cursor at the 
point in the recording that is five minutes after the dialysis 
tubing was placed in the water

4 Click the Analysis icon on the LabScribe toolbar (Figure 
GB-2-2 on page 2) to transfer the data between the cursors 
to the Analysis window.

5 In the table across the top of the data display on the 
Analysis window, the parameters, Title, Value1, Value2, 
V2-V1, and T2-T1 should appear. Any functions that does 
not appear in the table can be selected from the list of 
functions on the left side of the Analysis window by 
holding down the Control key on the keyboard as the name 
of the function is clicked (Control-Click).

6 Place a cursor at the point in the recording when the dialysis 
tubing with 1.0M HCl was lowered into the deionized water 
(Time = 0). Place the second cursor at the point in the 
recording that is five minutes after the dialysis tubing was 
placed in the water (Time = 5). Select pH on the Value 
from Ch menu in the upper left corner of the Analysis 
window.

7 Measure the values for the following parameters from the 
pH channel for the region of data selected:

• pH at Time = 0, which is Value1 on the pH channel.

• pH at Time = 5, which is Value2 on the pH channel.

• Change (∆) in pH after 5 Minutes, which is V2-V1 on the 
pH channel.

8 Record the names and values of the parameters, Title, 
Value1, Value2, V2-V1, and T2-T1 for the data of interest in 
the on-line notebook of LabScribe that is known as the 
Journal. The information can be entered by typing the 
names and values directly into the Journal. The measure-
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ments can also be entered into the Journal using the 
functions in the right-click menu of the Analysis window:

• Place the cursors in the appropriate locations for making 
measurements.

• Select Add Title to Journal, from the right-click menu, to 
add the names of the parameters measured to a table in the 
Journal.

• Select Add Data to Journal, from the right-click menu, to 
add the values of the parameters to the Journal.

9 Record the values for these parameters in Table GB-2-1 on 
page 5.

10 Click Save in the File menu. 

Exercise 2: Movement of Small Negative Ions 
Across a Membrane

Aim: To determine if small, negatively charged, 
hydroxide ions can move across a membrane from a 
region of higher concentration (1.0M NaOH) to a region 
of lower concentration (deionized water). 

Procedure
1 Place 100 mL of deionized water, at room temperature, in a 

clean 250 ml beaker. Add a stir bar to the beaker and place 
the beaker on the magnetic stirrer. Turn on the stirrer and 
position the stir bar to one side of the beaker bottom.

2 Remove the pH electrode from the beaker of deionized 
water. Blot the drops of deionized water from each device. 
Mount the electrode in a clamp on the ringstand. Position 
the pH electrode over the beaker of deionized water. Then, 
lower the tip of the electrode into the water. 

3 Turn on the stirrer so that the stir bar rotates evenly and 
moderately.

4 Click Start on the LabScribe Main window to begin 
recording. When the recording on the channel reaches a 
stable baseline, type the words Deionized Water on the 
comment line to the right of the Mark button. Press the 
Enter key on the keyboard to mark the recording.

5 After recording at least fifteen seconds of stable baseline, 
type the words Add Dialysis Tube w/ 1.0M NaOH on the 
comment line.

6 Suspend the dialysis tube containing 1.0M NaOH over the 
beaker of deionized water. As you lower the dialysis tube 
into the deionized water, press the Enter key on the 
keyboard to mark the recording. Tighten the clamp holding 
the dialysis tube so that about half the solution in the tube is 
below the surface of the deionized water. Make sure the 
bottom of the dialysis tube is not touching the stir bar.

7 Record the pH of the deionized water for five minutes. At 
the end of five minutes, click Stop to halt the recording. 

8 Select Save in the File menu. 

9 Turn off the magnetic stirrer. Remove the dialysis tube with 

the 1.0M NaOH from the beaker and discard the 1.0M 
NaOH as directed.

10 Remove the pH electrode from the beaker. Hold the 
electrode over the beaker used for collecting waste liquid, 
and rinse it with deionized water from a wash bottle. Blot 
any drops of water from the electrode and place it in a 
beaker of deionized water.

11 Remove the stir bar from the beaker of deionized water and 
rinse it with deionized water from a wash bottle. Discard the 
deionized water.

Data Analysis
1 Scroll to the section of data recorded during Exercise 2. 

Display the complete recording from Exercise 2 on the Main 
window.

2 Place a cursor on the stable baseline recorded just before 
the dialysis tubing containing 1.0M NaOH was lowered into 
the beaker of deionized water. Place the second cursor at 
the point in the recording that is five minutes after the 
dialysis tubing was lowered into the deionized water.

3 Transfer the data between the cursors to the Analysis 
window.

4 Make sure the same parameters used in Exercise 1 appear 
In the table across the top of the data display on the 
Analysis window.

5 Place a cursor at the point in the recording when the dialysis 
tubing containing 1.0M NaOH was lowered into the 
deionized water (Time = 0). Place the second cursor at the 
point in the recording that is five minutes after the dialysis 
tubing was placed in the deionized water.(Time = 5). Select 
pH on the Value from Ch menu in the upper left corner of 
the Analysis window.

6 Place a cursor at the point in the recording when the dialysis 
tubing with 1.0M NaOH was placed in the beaker of 
deionized water (Time = 0). Place the second cursor at the 
point in the recording that is five minutes after the dialysis 
tubing was placed in the water (Time = 5). Select pH on the 
Value from Ch menu in the upper left corner of the 
Analysis window.

7 Measure the values for the following parameters from the 
pH channel for the region of data selected:

• pH at Time = 0, which is Value1 on the pH channel.

• pH at Time = 5, which is Value2 on the pH channel.

• Change (∆) in pH after 5 Minutes, which is V2-V1 on the 
pH channel.

8 Use the one of the techniques described in Step 8 of 
Exercise 1 to record the values of the parameters in the 
Journal.

9 Record the values for these parameters in Table GB-2-1 on 
page 5.

10 Click Save in the File menu. 
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Exercise 3: Movement of Large Ions Across a 
Membrane

Aim: To determine if large, negatively charged, acetate 
ions can move across a membrane from a region of 
higher concentration (1.0M Na Acetate) to a region of 
lower concentration. 

Procedure
1 Place 100 mL of deionized water, at room temperature, in a 

clean 250 ml beaker. Add a stir bar to the beaker and place 
the beaker on the magnetic stirrer. Turn on the stirrer and 
position the stir bar to one side of the beaker bottom.

2 Remove the pH electrode from the beaker of deionized 
water. Blot the drops of deionized water from each device. 
Mount the electrode in a clamp on the ringstand. Position 
the pH electrode over the beaker of deionized water. Then, 
lower the tip of the electrode into the water. 

3 Turn on the stirrer so that the stir bar rotates evenly and 
moderately.

4 Click Start on the LabScribe Main window to begin 
recording. When the recording on the channel reaches a 
stable baseline, type the words Deionized Water on the 
comment line to the right of the Mark button. Press the 
Enter key on the keyboard to mark the recording.

5 After recording at least fifteen seconds of stable baseline, 
type the words Add Dialysis Tube w/ 1.0M Na Acetate on 
the comment line.

6 Suspend the dialysis tube containing 1.0M Na Acetate over 
the beaker of deionized water. As you lower the dialysis 
tube into the deionized water, press the Enter key on the 
keyboard to mark the recording. Tighten the clamp holding 
the dialysis tube so that about half the solution in the tube is 
below the surface of the deionized water. Make sure the 
bottom of the dialysis tube is not touching the stir bar.

7 Record the pH of the deionized water for five minutes. At 
the end of five minutes, click Stop to halt the recording. 

8 Select Save in the File menu. 

9 Turn off the magnetic stirrer. Remove the dialysis tube with 
the 1.0M Na Acetate from the beaker and discard the 1.0M 
Na Acetate as directed.

10 Remove the pH electrode from the beaker. Hold the 
electrode over the beaker used for collecting waste liquid, 
and rinse it with deionized water from a wash bottle. Blot 
any drops of water from the electrode and place it in a 
beaker of deionized water.

11 Remove the stir bar from the beaker of deionized water and 
rinse it with deionized water from a wash bottle. Discard the 
deionized water.

Data Analysis
1 Scroll to the section of data recorded during Exercise 3. 

Display the complete recording from Exercise 3on the Main 
window.

2 Place a cursor on the stable baseline recorded just before 
the dialysis tubing containing 1.0M Na Acetate was lowered 
into the beaker of deionized water. Place the second cursor 
at the point in the recording that is five minutes after the 
dialysis tubing was lowered into the deionized water.

3 Transfer the data between the cursors to the Analysis 
window.

4 Make sure the same parameters used in Exercises 1 and 2 
appear In the table across the top of the data display on the 
Analysis window.

5 Place a cursor at the point in the recording when the dialysis 
tubing containing 1.0M Na Acetate was lowered into the 
deionized water (Time = 0). Place the second cursor at the 
point in the recording that is five minutes after the dialysis 
tubing was placed in the deionized water.(Time = 5). Select 
pH on the Value from Ch menu in the upper left corner of 
the Analysis window.

6 Place a cursor at the point in the recording when the dialysis 
tubing with 1.0M Na Acetate was placed in the beaker of 
deionized water (Time = 0). Place the second cursor at the 
point in the recording that is five minutes after the dialysis 
tubing was placed in the water (Time = 5). Select pH on the 
Value from Ch menu in the upper left corner of the 
Analysis window.

7 Measure the values for the following parameters from the 
pH channel for the region of data selected:

• pH at Time = 0, which is Value1 on the pH channel.

• pH at Time = 5, which is Value2 on the pH channel.

• Change (∆) in pH after 5 Minutes, which is V2-V1 on the 
pH channel.

8 Use the one of the techniques described in Step 8 of 
Exercise 1 to record the values of the parameters in the 
Journal.

9 Record the values for these parameters in Table GB-2-1 on 
page 5.

10 Click Save in the File menu. 

Questions
1 During the five minutes that the dialysis sac containing 1.0M 

HCl was placed in the beaker of deionized water, what 
happened to the pH of the water? What caused the result 
that you recorded?

Table GB-2-1: Changes in pH during Movement 
of Ions.

Solut ion in 
Dialysis Tubing

pH Level

T=0 Mins T=5 Mins Change (∆ )

1.0M HCl

1.0M NaOH

1.0M Na Acetate
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2 During the five minutes that the dialysis sac containing 1.0M 
NaOH was placed in the beaker of deionized water, what 
happened to the pH of the water? What caused the result 
that you recorded?

3 During the five minutes that the dialysis sac containing 1.0M 
Na Acetate was placed in the beaker of deionized water, 
what happened to the pH of the water? What caused the 
result that you recorded?

4 If any of the ions diffused across the membrane, which one 
diffused more quickly?

5 What would increase the rate of diffusion of an ion across a 
membrane?
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